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Work is either fun or drudgery.
It depends on your attitude.
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October 6th
HDTV Transition
Almost Here
With Walt

A few years ago, Walt Ordway gave us a presentation
on HDTV and a year later
gave us a presentation on
Digital Cinema. Well, Walt
will be coming to our October 6th meeting to give us an
update on HDTV. We are
getting closer to the magic
date of February 17, 2009,
which will be the last day of
analog television in the
USA. So, Walt's current
presentation will give us a
quick overview of the original FCC announcement
about HDTV and that analog TV would end on
December 31, 2006. Then
he'll tell us what happened
and why it got changed to
February 17, 2009. He will
give us more info about

Ordway

which of us will be and
which of us won't be affected. He will also tell us
what we need to do if we
fall in the category of ―being
affected.‖
Since his presentation will
be on October 6, 2008, he
will also be able to tell us
about an analog to digital
TV conversation in a city in
North Carolina on September 8, 2008.
As a little side line, Walt
will also give us some info
about HD radio.
So, if you want to get the
latest word on HDTV, make
sure you're at the October
meeting.
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President’s Thoughts
By U. A. Garred Sexton
The efforts that some of the people that present to operation moved to my house only to discover
us will go to in order to fulfill the promise to give that no one knew the code to sign on to the WiFi.
us a program are impressive.
At that point Robin Ziegler used his phone card
I was going to be out of town at the time of our
to get on the Internet and proceeded to make an
September meeting so to be sure everything
outstanding presentation that was received with
would work, because this was not our regular
rapt attention by the members attending. The
meeting night, I contacted the Salvation Army
amount of effort put forth on his part is an examand was assured that the meeting room was avail- ple of the above.
able. After I left town, there was a call at home
on the answering machine that there was an
Boy, talk about going above and beyond the call
error, the room was not available.
of duty!
Tom Tucknott did not get this information so he
and our speaker showed up at the Salvation
Army to discover there was no place to have the
meeting. Robin Ziegler, from Google, was informed that neither the room nor Internet access
were available but he said he had a way of getting on line.
To Plan B – it was decided to go to my home
where Internet access would be available. So the

Tip

October will be a busy month – we will have an
election of officers and a special SIG presentation by Harold Pfiffner at Sexton‘s house. If the
SIG runs out of time it will continue on another
Thursday night.
Unfortunately, by the time you get this news letter the SIG will have occurred. The reminder
about the SIG was to be sent out by Email. If this
does not work for you let me know.

TV Placement In Small Spaces
From Smart Computing

Although a small, intimate room probably won't
accommodate a 50-inch HDTV, you don't have
to give up on your dream of having a wide
screen TV in your 12- x 12-foot bedroom or
family room.

have a bulkier CRT (cathode-ray tube) TV, not
to mention the space the TV stand itself usually
takes up.

And because you can sit closer to HDTVs than
you could to analog sets (the closer you sit to an
Consider a flat-panel LCD TV, which you can
analog TV, the more horizontal scan lines your
mount on a wall. Wall mounting saves at least 12 eyes detect), you can actually put a good-sized
inches of space that you'd usually lose when you screen in a small space.
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Internet Talk
By Frank Chao
Member, GS-BUG
This is the 108th Internet Talk
article for The Bug Report, a
publication of the Greater South
Bay PC Users Group (GSBUG).
Liz and I are now active in the
Tucson Computer Society. Their
Web site is at www.aztcs.org.
We will use what we learn from
these folks to provide you with
future articles in this series.

Look for a section called
visit you for $169+ for the first
―Support‖ or ―Owner's manuals‖ hour.
or ―Documentation.‖
Now, let‘s back track. Think
If the manufacturer‘s website
about how you could prevent this
does not have the manual, try
predicament in the first place.
―diplodocs.com‖ at
You need to label all of the cahttp://safemanuals.com.
bles that connect your computer
to your network equipment.

TUCSON COMPUTER SOCIETY WEB PAGE
The Tucson Computer Society
publishes a Meeting Notes page
at
http://www.aztcs.org/
meeting_notes/
meeting_notes.shtml
On this page, you will find hyperlinks to Adobe Acrobat PDF
documents that contain information from some of their meetings.
Some recent subjects include:
Identity Theft
Accessing Libraries Online
Training for Digital Photography
and
All About Linux
FINDING OWNERS
MANUALS

Finally try searching at Google
by putting in the name of the
manufacturer followed by the
model number or model name.
LABELING COMPUTER
CABLES
During the month of August, Liz
and I helped several nice folks
with their computers and about
half of the problems that we resolved were caused by incorrect
cable connections.

Here is a typical scenario: your
kid dismantles your computer
and/or its broadband modem
If you are looking for an owner‘s
while cleaning. He then puts it
manual for a car, a home appliback together with one or more
ance, a camera, a computer, or
cables inserted incorrectly. Now
just about anything, start your
your computer can‘t reach the
search at the manufacturer‘s
Internet and you are now considwebsite.
ering phoning the Geek Squad to

Being tightwads, Liz and I label
all our computer cables with a
permanent ink marker and dull,
writable Scotch tape. Some of
our friends at the Tucson Computer Society use a Brother label
maker, which is a bit pricey, but
the labels are a lot better looking
than ours.
If you use a Dymo label maker,
you will have to use super glue to
stick the labels on permanently,
since the lame adhesive they use
eventually dries out and causes
their labels to fall off.
Liz and I sometimes use a permanent ink pen to write on the
exterior of a cable in order to
avoid having to create a label.
This works well for grey or white
colored cables but is not feasible
for black colored cables.
ENTRY-LEVEL BROADBAND
At the entry-level of broadband
Internet, ―Asynchronous Digital
Subscriber Line‖ which is also
known as ―ADSL‖ or ―DSL‖
continues to be cheaper than
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cable modem or satellite dish
Internet. Let me illustrate this
with some local examples:
DSL EXAMPLE: AT&T
If you go to http://www.att.com
and click on ―Internet‖ and put
in the North Torrance Zip Code
of 90504, and then click on the
―Internet & DSL‖ button, you
will be offered ―Basic DSL‖
service for $14.99. If you click
on this offer, you will find that
they promise not to raise the
price for 2 years:

http://gsbug.apcug.org

SATELLITE INTERNET
OPTION: DISH NETWORK
Now, let‘s us go to Dish Network‘s Website at
www.dishnetwork.com.
Click on ‗Shop,‘ then click on
‗Internet.‘ Finally click on
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dem connection at 56 kilobits
per second, you probably will
not appreciate the faster speed of
entry-level cable or satellite, and
you will probably prefer the
lower price of DSL . At least
that is what several GS-BUG
and several Tucson Computer
Society members have told us.
Liz and I generally recommend
that new broadband users sign
up for entry-level ADSL service
instead of the pricier cable modem service. If you win the lottery, you can always upgrade to
a pricier, faster service option!
TWO DSL HOOKUPS FOR
REDUNDANCY

‗Satellite Internet.‘

Two GS-BUG members have
also stated that because entryYou will discover that the low- level ADSL is cheaper, they
est level of satellite Internet ser- chose to put two ADSL connecvice costs $49.95 per month.
tions into their homes for redunBOTTOM LINE AGAIN:
dancy for a lower total price
DSL IS THE CHEAPEST
compared to the monthly cost a
CABLE INTERNET EXAMsingle cable modem or satellite
PLE: TIME WARNER
The above examples illustrate
Internet hookup. Here is how
the following rule-of-thumb:
this works:
If, instead, you go to
At the lowest, entry-level of
www.timewarnerla.com/
broadband service: DSL is
For each phone line in your
pricingGuides/PDFs08/1050-PL cheaper than cable modem
home, you order a unique DSL
-0208.pdf you will find that the which is cheaper than satellite. connection for about $15 per
lowest cost option is $34.95 per
month. Hence, if you have two
month for a resident of the Tor- Some GSBUG members have
phone lines at your home, you
rance area.
stated to me that they can justify can order two ADSL connecspending the extra money for a tions for a total of $30 per
Note that both choices are excable modem or a satellite dish month. Then you would connect
actly the same. At $35 per
connection because they are
some of the computers in the
month, Time Warner's perthree or more times faster than
house to one of the ADSL conmonth price for the lowest speed entry-level DSL service.
nections and other computers are
of cable modem Internet in
then connected to the other
North Torrance has been about However, if you are new to fast, ADSL connection. If one Interthe same for about 4 years.
broadband Internet and all you
net connection fails for any reahave ever had is a dial-up moson, then you can re-route all of
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its associated computers to the
ADSL connection which is still
operational. Of course, when the
ADSL provider has a total outage
in your residential area, then both
of your ADSL connections will
fail.
DIAL-UP MODEMS FOR A
BACKUP
Liz and I continue to recommend
that you use a dial-up modem for
a backup when your broadband
Internet connection fails. We
continue to use the free versions
of NetZero and Juno and the dial
-up version of the Los Angeles
Free-Net as a backup connection
to the Internet whenever our cable modem connection has an
outage.
Since moving to Tucson in
March, we have reverted to a dial
-up connection four times when
our cable modem service had
outages. On all four occasions
we were pleasantly surprised at
how easy it was to attach a USB
56-kilobits per second modem to
a computer and run the ‗Connect
To‘ wizard to get Windows to
make a dial-up connection to the
Internet.

No where at this web site do they
disclose that this entire site is a
satirical ―put-on.‖ All of the persons in this site are actors. This
web site is a creation of Chelsea
Peretti, a professional comedian.
Her web site is at
www.chelseaperetti.com.

When Liz and I first saw the
―Black People Love Us‖ web
site, we did not know what to
make of it. We then went to
SOME WEB SITES ARE ―PUT- Google and we searched on:
ONS‖
―Black People Love Us wiki.‖
When browsing the Internet,
please be aware of the fact that
some Web sites are satirical and/
or humorous and/or malicious
―put-ons.‖
Go to http://
blackpeopleloveus.com

On the second page of ―hits,‖ we
found the following Wikipedia
page at http://en.wikipedia.org/
wiki/Chelsea_Peretti

and credits Peretti with creating
it.
At the above-mentioned Wikipedia page, we also found the link
to Chelsea Peretti's Web page.
If you have any questions or
problems, I can be contacted by
the following methods:
1. Send me e-mail at:
fchao2@yahoo.com
2. Send ―snail‖ United States
Postal Service (USPS) mail to
Frank Chao
405 E. Wetmore Rd.
#117-484
Tucson, AZ 85705-1792

This Wikipedia page refers to
―Black People Love Us‖ as satire Or sell your computer and take
up golf instead!!
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E-Mailing Photographs

By Richard Kennon

Amador Computer Users Group, CA
www.acug.net
Drtrdguy@volcano.net
Obtained from APCUG with the author's permission for publication by
APCUG member groups.

First, we must understand that
photograph (image) size in the
camera and in the computer is
measured in pixels. These are the
basic dots of color that make the
picture. Do not pay any attention
to anything that says ‗inches‘ or
‗pixels per inch.‘ These terms are
meaningless when we are considering a picture either in the camera or in the computer.
They may come into play later if
we want to print the photo on
paper. But, that is another subject
for another time. For now, we
think only of pixels.
Most cameras record too many
pixels to e-mail. For instance, a 6
megapixel camera will make a
picture about 3000 pixels wide
by 2000 pixels tall and the file
size may be several megabytes.
Our screens are usually only
about 1000 pixels wide (some are
larger and some smaller). So, if
we e-mail the native picture, it
will be wider than the screen for
the recipient and the file will be
so large, it may take ―forever‖ to
download to the recipient‘s computer. It is possible the service
provider will not even accept it.

There are two things we must do
to make a photo e-mailable. The
first is to resize or resample the
picture. We want to change the
picture width from 3000 pixels to
800 pixels, for instance. This
process is called resizing or resampling. We have to pick the
best 800 pixels out of the 3000 to
represent our photo. Well, no,
that is not exactly correct but it
simplifies things to think of it
that way. We don‘t have to worry
about it because a lot of very
smart programmers have developed ways (algorithms) to help
us. Just remember, you want to
resize or resample to get the
photo down to a size convenient
for e-mailing. I usually use 800
pixels or 900 pixels width for
pictures I attach to e-mails.

5 or 6. I usually use 6.
How do you do this? First, I will
describe how to do it with a free
Microsoft program. Then I will
try to look at some other programs.

Microsoft Power Toys for XP
has a Resize Pictures toy that is
slick and easy but feedback says
it only works on XP. It can be
downloaded at . Right click on an
image name or thumbnail in Explorer or My Computer and
choose Resize Pictures. You are
limited to four specific sizes but
they are good choices. They
don‘t tell us what compression
they are using but the results
look OK. Unless you tell them
under Advanced to replace the
image in the file, it will make a
The second thing to do to make a copy. That‘s good. They will add
photo e-mailable is to save it in the word, ―Large‖, ―Medium‖ or
JPEG format (.jpg). That is a
―Small‖ to the end of the name
format that reduces file size a lot you have chosen.
and picture quality a little so the
picture can be downloaded more
quickly and still be nice to look
at. Some software programs give
you choices of compression
amount with numbers ranging
from 1 to 10. One will result in a
very small file but the picture
quality will not be good at all. A
10 will give the very best quality
but with a very large file size. A If you are happy with this solureasonable compromise is to use tion, then read no further.
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But, if you want to use a picture more automated but not any easediting program, maybe this will ier to use than Elements. First,
help.
click on ‘Tools>Options>EMail.‘ Then select the width you
In Photoshop Elements 5, click
want in pixels. There are six
on ‘Image>Resize>Image Size’ choices. Then click on ‘Apply’
and this window will pop up.
and ‘OK.‘
Note that there is some garbage
at the bottom about ‗inches‘ but The next step is to click on
we will ignore that. First we will ‘File>E-Mail’ and you will get
click the ‘Resample Image’ box. three choices of how you want to
That puts the Pixel Dimensions e-mail your photos. Fortunately,
in play and that is what we want. I use Outlook Express so my
I selected the ‗Width‘ box and
choice is listed.
changed the width to 800 pixels.
Since the ‘Constrain ProporWhen I clicked on Outlook Extions’ box is selected, that is all I press, an e-mail page popped up
have to do.
with the photo attached. At this
point we can write something
Note, down at the bottom, that
else on the e-mail and send it. I
we have several choices of sam- recommend this so the recipient
pling algorithms. This is frosting will know it is really from you
on the cake. I read somewhere
and not something sent out by a
that I should use ‘Bicubic
virus. When I receive e-mails
Sharper‘ when downsizing so
that only say ‗Attached,‘ I delete
that is what I do. Most programs them without looking at the atdon‘t give us all these choices.
tachment. This saved me one
Then we should click on
time when I received a virus
‘File>Save As’ and give the
from my sister-in-law that she
photo a new name. I often just
did not know she sent. She spent
use the same name and add
weeks and dollars getting her
‗_800px‘ so the next time I will computer back up. Oh, I digress.
know it is ready to e-mail. Here If you want to send more than
we can choose the JPEG format one picture (and, who doesn‘t?),
and the compression amount.
you must select the picture and
Photoshop Elements 6 is out now
and sells for about $100. If you
are able to spend that much and
want one of the best editing programs, I highly recommend it.
Let‘s look at Picasa2. It is a free
program from Google and looks
really good but I do not have
much experience with it. By all
means, try it first because the
price is right! When it comes to e
-mailing photographs, it is a little
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click on the ‗Hold‘ button near
the bottom of the screen. Do this
for each photo you want to send
and they will all be attached to
the e-mail. The program automatically chooses JPEG format
and a compression ratio but does
not tell you. That is okay as the
pictures I tried looked good. Picasa2 has considerable capability
for editing photos in many respects. Try it!
There are many other editing
programs that I haven‘t mentioned and have no experience
with. In all cases you want to
change the picture‘s size in pixels by resizing or resampling.
Pay no attention to anything that
says ‗inches‘ as that will have no
meaning for this process. Sometime later we will talk about
printing pictures and then we will
use inches.
This article has been provided to
APCUG by the author solely for
publication by APCUG member
groups. All other uses require the
permission of the author (see e-mail
address above).

(From Vista—Part 9, page 9)
some that are free. I've been using the free version of Zone
Alarm for many years and I'm
satisfied with its protection. It
also creates a log that I can use
to examine attempts to connect
to my computer. You can find it
on the Internet at
www.zonealarm.com.
This article has been provided to APCUG by the author solely for publication by APCUG member groups. All
other uses require the permission of
the author (see e-mail address above).
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Moving on to Vista — Part 9

by Neil Stahfest
Tacoma Area PC User Group, WA
www.tapcug.org
ncstahfest@msn.com

fact it told me to use the one
built into Vista. I turned to the
installation CD that came with
the printer and reinstalled the
As I mentioned last month,
printer driver from the CD. It
Vista's Service Pack 3 is out. I
worked and I can print over my
didn't see any real changes in
home network using a wireless
my computer after I installed it,
connection again. I have no idea
most of the modifications are
why this happened but at least
supposed to deal with computer
one other TAPCUG member
security. I have since encounalso discovered a printer driver
tered a problem with my printer.
problem after installing Vista
SP1.
I don't print too often from my
―Vista computer‖ so the problem
Speaking of security (see parawasn't immediately obvious.
graph 1), Windows Vista, like
When I did try to print some
Windows XP, comes with a firedocuments they ―disappeared‖
wall program pre-installed. As
without printing. My first
all you computer gurus know, a
thought was that I had changed
computer firewall is a hardware
the firewall on my print server
or software tool that examines
and locked out connections from
all Internet traffic letting only
other computers on my home
―safe‖ traffic into your comnetwork (I've done that before).
puter. The firewall for Vista was
No that wasn't it. After checking
supposed to scan Internet traffic
and finding that I could transfer
both entering and leaving your
files between my computers, I
computer. I can hear some of
went to the printer section of my
you saying, ―If I scan incoming
control panel. That's where I distraffic to be safe, why do I care
covered that Vista wanted a new
about outbound traffic?‖ Well,
printer driver installed. I don't
incoming traffic is the bigger
remember any problems with the
threat to you. Using pre-defined
printer when I started using this
rules it determines which procomputer. As I recall, Vista recgrams are allowed to use your
ognized my printer (a fairly new
network connection or which
HP ink jet printer) and it just
ports can be used for communiworked. Anyway, a search of
cations. If some spyware, TroHewlett Packard's web site didjans or malicious ―phone home‖
n't reveal a new printer driver. In
software slips past your firewall,
Obtained from APCUG with the author's permission for publication by
APCUG member groups.

they may allow someone to take
remote control of your computer
to attack it or other computers
through your Internet connection
(that's why Microsoft is always
sending you those security updates). So a firewall that scans
outbound traffic attempts to stop
this. To make a longer story
short, contrary to plans, the ability to check outbound traffic has
not been provided with Vista's
firewall.
Another shortcoming of Vista's
firewall is that it does not create
a log of all attempts to contact
your computer from a local network or the Internet. This kind
of record can be useful if you
suspect a hacker has been visiting your computer in the middle
of the night. Actually, there is a
way that you can modify Vista's
firewall to create a log and examine outbound traffic. The
process to set this up is probably
more complicated than most of
us would like to deal with so I
offer a much easier solution.
Turn off Vista's firewall and install a third party firewall program. Do not try to use two or
more firewall programs at the
same time. They do not play
well together. There are a number of firewall programs that
you can purchase as well as
(See Vista-Part 9, page 8)
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When to Turn Off Personal Computers
U.S. Department of Energy
Energy Efficiency and Renewable Energy.

A Consumer's Guide to Energy Efficiency and Renewable Energy
www.energy.gov/forconsumers.htm
If you're wondering when you
should turn off your personal
computer for energy savings,
here are some general guidelines
to help you make that decision.

negative impact on their service
life. The less time a PC is on, the
longer it will ―last.‖ PCs also
produce heat, so turning them off
reduces building cooling loads.

Watts, which is less than 10% of
its operating power consumption.

Make sure you have the powerdown feature set up on your PC
through your operating system
Though there is a small surge in For cost effectiveness, you also software. This has to be done by
energy when a computer starts
need to consider how much your you, otherwise the PC will not
up, this small amount of energy time is worth.
power down. If your PC and
is still less than the energy used
monitor do not have power-down
when a computer is running for If it takes a long time to shut
features, and even if they do, follong periods of time. For energy down the computer and then re- low the guidelines below about
savings and convenience, constart it later, the value of your
when to turn the CPU and monisider turning off:
time will probably be much
tor off.
greater than the value of the
• the monitor if you aren't
amount of electricity you will
Note: Screen savers are not engoing to use your PC for
save by turning off the computer. ergy savers. Using a screen saver
more than 20 minutes
may in fact use more energy than
• both the CPU and monitor
not using one and the powerPower-Down or
if you're not going to use
down feature may not work if
Sleep Mode Features
your PC for more than two
you have a screen saver actihours.
Many PCs available today come vated. In fact, modern LCD color
monitors do not need screen savwith a power-down or sleep
Make sure your monitors, print- mode feature for the CPU and
ers at all.
ers, and other accessories are on monitor. ENERGY STAR®
a power strip/surge protector.
computers power down to a sleep Tip
When this equipment is not in
Frozen in Action
mode that consume 15 Watts or
use for extended periods, turn off less power, which is around 70%
If you're photographing sports or
the switch on the power strip to less electricity than a computer
prevent them from drawing
without power management fea- other kinetic activities, you can
use extremes of shutter speed to
power even when shut off. If you tures.
accentuate the action. A slow
don't use a power strip, unplug
extra equipment when it's not in ENERGY STAR monitors have speed (1/15th of a second, for
use.
the capability to power down into example) will lead to blurring of
the figure, emphasizing its sense
two successive ―sleep‖ modes.
of motion. With fast shutter
Most PCs reach the end of their
speeds, you can stop action,
―useful‖ life due to advances in In the first, the monitor energy
technology long before the efconsumption is less than or equal such as capturing a high-jumper
hanging weightless while clearfects of being switched on and
to 15 Watts, and in the second,
off multiple times have a
power consumption reduces to 8 ing the bar.
From Smart Computing

GS-BUG Membership Application
[

] New

[ ] Renewal

[

] Update

I hereby apply for membership in the Greater South Bay PC Users Group. I understand I will be entitled to attend meetings, receive the monthly newsletter and be eligible for special offers that become available from time
to time.

Name (Please Print) First

Last

Address

City, State, Zip +4
Phone

E-Mail
Individual $36.00; Student $18.00; Family $48.00; Newsletter Subscription $18.00

Please mail check to: GS-BUG, Inc.—Membership; 241 Via Los Miradores, Redondo Beach, CA 90277-6761

SIG MEETINGS

CLASSIFIED ADS

Members may place personal ads of three (3) lines for
free. All other business and non-members ads: $2.00
per ad for 3 lines. Ads must be prepaid, camera-ready
copy, and received by the 15th of the month preceding
publication.
ADVERTISING RATES

GS-BUG accepts commercial advertising from members and outside businesses at the following rates:
Business Cards (3 1/2‖ x 2‖) ......... $15.00
Page Ad ......................................... $25.00
1/2 Page Ad ................................... $35.00
Full Page Ad .................................... 60.00
All prices are for single issue only. All advertisements
must be prepaid and received by the 15th of the month
preceding publication. All artwork must be camera
ready copy.
Checks payable to GS-BUG, Inc.
Mail to:
GS-BUG, Inc.—Advertising

3623 W. 227th St.,
Torrance, CA 90505-2522
LIBRARY

Shareware disks are available at the General Meeting
for $3.00 per disk and $5.00 per CD. Charges are to
recover duplication and distribution costs.

Daytime Hardware
Every Tuesday
1—4
Torrance Scout Center
Bob Hudak
rsh532@aol.com
Digital Imaging
Every Tuesday
9—12 noon Torrance Scout Center
Greg Neumann
Gbug_caller@aol.com
Linux
7:00 p.m.
George Porter

2nd Thursday
Garry Sexton‘s
310-373-5416
g19porter@verizon.net

Beginning Windows XP
3rd Thursday
7:00 p.m.
Garry Sexton‘s
Virginia Pfiffner
310-374-2410
vpfiffne@elcamino.edu
Internet
7:00 p.m.
Tom Tucknott

4th Thursday
Garry Sexton‘s
310-530-4992
ttucknott@socal.rr.com

SIG Meeting Addresses
Torrance Scout Center
2375 Plaza Del Amo, Torrance
Garry Sexton’s
3623 W. 227th St., Torrance

The Bug Report
The Greater South Bay PC Users Group
3623 W. 227th St.
Torrance, CA 90505

October 2008
Sunday

Monday

Tuesday

Wednesday
1

5

6
General
Meeting

7 SIG Meetings
Digital Imaging
Daytime
Hardware

Thursday
2

8

9
Board
Meeting

Friday

Saturday

3

4

10

11
Newsletter
Deadline

SIG Meeting
Linux

12
Columbus
Day

13
Columbus
Day—observed

14 SIG Meetings 15
Digital Imaging
Daytime
Hardware

16
SIG Meeting
Windows XP

17

18

19

20

21 SIG Meetings
Digital Imaging
Daytime
Hardware

23 SIG Meeting 24
Internet

25

26

27

28 SIG Meetings 29
Digital Imaging
Daytime
Hardware

Daylight
Savings Time
Ends

22

30

31
Halloween

